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Chapter 1

Tools User's Guide

The Tools application contains a number of stand-alone tools, which are useful when developing Erlang
programs.
cover A coverage analysis tool for Erlang.

cprof A profiling tool that shows how many times each function is called. Uses a kind of local call trace
breakpoints containing counters to achieve very low runtime performance degradation.

emacs - (erlang.el and erlang-start.el) This package provides support for the programming language
Erlang in Emacs. The package provides an editing mode with lots of bells and whistles,
compilation support, and it makes it possible for the user to start Erlang shells that run inside
Emacs.

eprof A time profiling tool; measure how time is used in Erlang programs. Erlang programs.
Predecessor of fprof (see below).

fprof Another Erlang profiler; measure how time is used in your Erlang programs. Uses trace to file to
minimize runtime performance impact, and displays time for calling and called functions.

instrument Utility functions for obtaining and analysing resource usage in an instrumented Erlang
runtime system.

make A make utility for Erlang similar to UNIX make.
tags A tool for generating Emacs TAGS files from Erlang source files.

xref A cross reference tool. Can be used to check dependencies between functions, modules,
applications and releases.

1.1 cover

1.1.1 Introduction

The module cover provides a set of functions for coverage analysis of Erlang programs, counting how
many times each executable line [page 8] is executed.

Coverage analysis can be used to verify test cases, making sure all relevant code is covered, and may be
helpful when looking for bottlenecks in the code.
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1.1.2 Getting Started With Cover
Example

Assume that a test case for the following program should be verified:

-module(channel) .
-behaviour(gen_server).

-export ([start_link/0,stop/0]) .
-export([alloc/0,free/1]). % client interface
—export([init/1,handle_call/3,terminate/2]). % callback functions

start_link() ->
gen_server:start_link({local,channel},channel, [],[]).

stop() ->
gen_server:call(channel,stop) .

%h%-Client interface functions—-------——————————————————————

alloc() ->
gen_server:call(channel,alloc).

free(Channel) —>
gen_server:call(channel,{free,Channel}).

%hh-gen_server callback functions----—-——-——-——-—————-———————— o

init(_Arg) ->
{ok,channels()}.

handle_call(stop,Client,Channels) ->
{stop,normal,ok,Channels};

handle_call(alloc,Client,Channels) ->
{Ch,Channels2} = alloc(Channels),
{reply,{ok,Ch},Channels2};

handle_call ({free,Channel},Client,Channels) ->
Channels2 = free(Channel,Channels),

{reply,ok,Channels2}.

terminate (_Reason,Channels) ->
ok.

%h%-Internal functions————-————————————m

channels() ->
[ch1l,ch2,ch3].

alloc([Channel|Channels]) ->
{Channel,Channels};
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alloc([]) ->
false.

free(Channel,Channels) ->
[Channel |Channels].

The test case is implemented as follows:

-module(test) .

-export([s/0]).

sO -
{ok,Pid} = channel:start_link(),
{ok,Ch1} = channel:alloc(),

ok = channel:free(Chl),
ok = channel:stop().

Preparation

First of all, Cover must be started. This spawns a process which owns the Cover database where all
coverage data will be stored.

1> cover:start().
{0k,<0.30.0>}

To include other nodes in the coverage analysis, use start/1. All cover compiled modules will then be
loaded on all nodes, and data from all nodes will be summed up when analysing. For simplicity this
example only involves the current node.

Before any analysis can take place, the involved modules must be Cover compiled. This means that some
extra information is added to the module before it is compiled into a binary which then is loaded [page
9]. The source file of the module is not affected and no .bean file is created.

2> cover:compile_module(channel) .
{ok,channel}

Each time a function in the Cover compiled module channel is called, information about the call will
be added to the Cover database. Run the test case:

3> test:s().
ok

Cover analysis is performed by examining the contents of the Cover database. The output is
determined by two parameters, Level and Analysis. Analysis is either coverage or calls and
determines the type of the analysis. Level is either module, function, clause, Or 1ine and determines
the level of the analysis.
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Coverage Analysis

Analysis of type coverage is used to find out how much of the code has been executed and how much
has not been executed. Coverage is represented by a tuple {Cov,NotCov}, where Cov is the number of
executable lines that have been executed at least once and NotCov is the number of executable lines
that have not been executed.

If the analysis is made on module level, the result is given for the entire module as a tuple
{Module, {Cov,NotCov}}:

4> cover:analyse(channel,coverage,module) .
{ok,{channel,{14,1}}}

For channel, the result shows that 14 lines in the module are covered but one line is not covered.

If the analysis is made on function level, the result is given as a list of tuples
{Function, {Cov,NotCov}}, one for each function in the module. A function is specified by its module
name, function name and arity:

5> cover:analyse(channel,coverage,function).

{ok, [{{channel,start_link,0},{1,0}},
{{channel,stop,0},{1,03}},
{{channel,alloc,0},{1,0}},
{{channel,free,1},{1,0}},
{{channel,init,1},{1,0}},
{{channel,handle_call,3},{5,0}},
{{channel, terminate,2},{1,03}7},
{{channel, channels,0},{1,0}},
{{channel,alloc,1},{1,1}},
{{channel, free,2},{1,0}}1}

For channel, the result shows that the uncovered line is in the function channel:alloc/1.

If the analysis is made on clause level, the result is given as a list of tuples {Clause, {Cov,NotCov}}, one
for each function clause in the module. A clause is specified by its module name, function name, arity
and position within the function definition:

6> cover:analyse(channel,coverage,clause).

{ok, [{{channel,start_link,0,1},{1,0}},
{{channel,stop,0,1},{1,0}},
{{channel,alloc,0,1},{1,0}},
{{channel,free,1,1},{1,0}},
{{channel,init,1,1},{1,0}},
{{channel,handle_call,3,1},{1,0}},
{{channel,handle_call,3,2},{2,0}},
{{channel,handle_call,3,3},{2,0}},
{{channel,terminate,2,1},{1,0}},
{{channel, channels,0,1},{1,0}},
{{channel,alloc,1,1},{1,0}},
{{channel,alloc,1,2},{0,1}},
{{channel,free,2,1},{1,0}}31%}

For channel, the result shows that the uncovered line is in the second clause of channel:alloc/1.

Finally, if the analysis is made on line level, the result is given as a list of tuples {Line,{Cov,NotCov}},
one for each executable line in the source code. A line is specified by its module name and line number.
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7> cover:analyse(channel,coverage,line).

{ok, [{{channel,9},{1,0}},
{{channel,12},{1,0}},
{{channel,17},{1,03}},
{{channel,20},{1,0}},
{{channel,25},{1,0}},
{{channel,28},{1,0}},
{{channel,31},{1,0}7},
{{channel,32},{1,0}},
{{channel,35},{1,0}},
{{channel,36},{1,0}},
{{channel,39},{1,03}},
{{channel,44},{1,0}7},
{{channel,47},{1,0}7},
{{channel,49},{0,13}},
{{channel,52},{1,0}}1}

For channel, the result shows that the uncovered line is line number 49.

Call Statistics

Analysis of type calls is used to find out how many times something has been called and is represented
by an integer Calls.

If the analysis is made on module level, the result is given as a tuple {Module,Calls}. Here Calls is the
total number of calls to functions in the module:

8> cover:analyse(channel,calls,module).
{ok,{channel,12}}

For channel, the result shows that a total of twelve calls have been made to functions in the module.

If the analysis is made on function level, the result is given as a list of tuples {Function,Calls}. Here
Calls is the number of calls to each function:

9> cover:analyse(channel,calls,function).

{ok, [{{channel,start_link,0},1},
{{channel,stop,03},1},
{{channel,alloc,0},1},
{{channel,free,1},1%},
{{channel,init,1},1%},
{{channel,handle_call,3},3},
{{channel,terminate,2},1},
{{channel,channels,0},1},
{{channel,alloc,1},1},
{{channel,free,2},1}1}

For channel, the result shows that handle _call/3 is the most called function in the module (three
calls). All other functions have been called once.

If the analysis is made on clause level, the result is given as a list of tuples {Clause,Calls}. Here Calls
is the number of calls to each function clause:
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10> cover:analyse(channel,calls,clause).

{ok, [{{channel,start_link,0,1},1},
{{channel,stop,0,1},1},
{{channel,alloc,0,1},1},
{{channel,free,1,1},1},
{{channel,init,1,1},1},
{{channel,handle_call,3,1},17},
{{channel,handle_call,3,2},17},
{{channel,handle_call,3,3},17},
{{channel,terminate,2,1},1},
{{channel, channels,0,1},1},
{{channel,alloc,1,1},1},
{{channel,alloc,1,2},0},
{{channel,free,2,1},1}1}

For channel, the result shows that all clauses have been called once, except the second clause of
channel:alloc/1 which has not been called at all.

Finally, if the analysis is made on line level, the result is given as a list of tuples {Line,Calls}. Here
Calls is the number of times each line has been executed:

11> cover:analyse(channel,calls,line).

{ok, [{{channel,9},1},
{{channel, 12},1},
{{channel,17},13},
{{channel,20},1},
{{channel,25},1},
{{channel,28},1},
{{channel,31},1},
{{channel,32},1},
{{channel,35},1},
{{channel,36},17},
{{channel,39},1},
{{channel,44},1},
{{channel,47},1},
{{channel,49},0},
{{channel,52},1}]1}

For channel, the result shows that all lines have been executed once, except line number 49 which has
not been executed at all.

Analysis to File
A line level calls analysis of channel can be written to a file using cover:analysis to file/1:

12> cover:analyse_to_file(channel).
{ok,"channel.COVER.out"}

The function creates a copy of channel.erl where it for each executable line is specified how many
times that line has been executed. The output file is called channel.COVER. out.
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File generated from channel.erl by COVER 2001-05-21 at 11:16:38

>k >k >k >k >k >k >k >k >k >k >k >k >k >k >k >k ok %k ok ok ok ok ok ok ok ok >k >k >k >k >k >k >k 5k ok ok ok ok 5k 5k %k %k >k >k >k >k >k 5k 5K ok 5k 5k >k >k >k >k >k >k >k >k >k >k >k ok %k %k %k %k >k %k >k >k >k >k >k k

-module(channel) .
-behaviour(gen_server) .

-export ([start_1ink/0,stop/0]).
-export([alloc/0,free/1]). % client interface
-export([init/1,handle call/3,terminate/2]). % callback functions

start_link() ->
gen_server:start_link({local,channel},channel, []1,[]).

stop() ->
gen_server:call(channel,stop) .

%h%h-Client interface functions-------—-——-——-—————————————————————

alloc() ->
gen_server:call(channel,alloc).

free(Channel) ->
gen_server:call(channel, {free,Channel}).

%hkh-gen_server callback functions—----———-—=—=————————————————————

init(Arg) ->
{ok,channels()}.

handle call(stop,Client,Channels) ->
{stop,normal, ok,Channels};

handle_call(alloc,Client,Channels) ->
{Ch,Channels2} = alloc(Channels),
{reply,{ok,Ch},Channels2};

handle call({free,Channel},Client,Channels) ->
Channels2 = free(Channel,Channels),

{reply,ok,Channels2}.

terminate (_Reason,Channels) ->
ok.

%hh-Internal functions-——-—-—————-——-——-——m——m——m oo

channels() ->
[ch1l,ch2,ch3].

alloc([Channel|Channels]) ->

{Channel,Channels};
alloc([]) ->
false.
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|
| free(Channel,Channels) ->
1..] [Channel |Channels] .

Conclusion

By looking at the results from the analyses, it can be deducted that the test case does not cover the case
when all channels are allocated and test . erl should be extended accordingly.
Incidentally, when the test case is corrected a bug in channel should indeed be discovered.

When the Cover analysis is ready, Cover is stopped and all Cover compiled modules are unloaded [page
9]. The code for channel is now loaded as usual from a .bean file in the current path.

13> code:which(channel).
cover_compiled

14> cover:stop().

ok

15> code:which(channel).
"./channel.beam"

1.1.3 Miscellaneous
Performance

Execution of code in Cover compiled modules is slower and more memory consuming than for
regularly compiled modules. As the Cover database contains information about each executable line in
each Cover compiled module, performance decreases proportionally to the size and number of the
Cover compiled modules.

Executable Lines

Cover uses the concept of executable lines, which is lines of code containing an executable expression
such as a matching or a function call. A blank line or a line containing a comment, function head or
pattern in a case- Or receive statement is not executable.

In the example below, lines number 2,4,6,8 and 11 are executable lines:

1: is_loaded(Module,Compiled) ->

2 case get_file(Module,Compiled) of
3 {ok,File} ->

4: case code:which(Module) of
5: ?TAG ->

6: {loaded,File};

7 - >

8 unloaded

9: end;

10: false ->

11: false

12: end.
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Code Loading Mechanism

When a module is Cover compiled, it is also loaded using the normal code loading mechanism of
Erlang. This means that if a Cover compiled module is re-loaded during a Cover session, for example
using c (Module), it will no longer be Cover compiled.

Use cover:is_compiled/1 or code:which/1 to see if a module is Cover compiled (and still loaded) or
not.

When Cover is stopped, all Cover compiled modules are unloaded.

1.1.4 Using the Web Based User Interface to Cover
Introduction

To ease the use of Cover there is a web based user interface to Cover called WebCover. WebCover is
designed to be started and used via WebTool. It is possible to Cover compile Erlang modules and to
generate printable Cover and Call analyses via the web based user interface.

Start the Web Based User Interface to Cover

To start WebCover you can either start WebTool, point a browser to the start page of WebTool and start
WebCover from there, or you can use the start_webtool script to start Webtool, WebCover and a
browser. See WebTool documentation for further information.

Currently WebCover is only compatible with Internet Explorer and Netscape Navigator 4.0 and higher.

Navigating WebCover

From the menu in the lefthand frame you can select the Nodes, Compile, Import Or Result page.

From the Nodes page you can add remote nodes to participate in the coverage analysis. Coverage data
from all involved nodes will then be merged during analysis.

From the Compile page you can Cover compile .erl or .bean files.

From the Import page you can import coverage data from a previous analysis. Imported data will then
be merged with the current coverage data. Note that it is only possible to import files with the
extension .coverdata.

From the Result page you can analyse, reset or export coverage data.
Please follow the instructions on each page.
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1.2 cprof - The Call Count Profiler

cprof is a profiling tool that can be used to get a picture of how often different functions in the system
are called.

cprof uses breakpoints similar to local call trace, but containing counters, to collect profiling data.
Therfore there is no need for special compilation of any module to be profiled.

cprof presents all profiled modules in decreasing total call count order, and for each module presents all
profiled functions also in decreasing call count order. A call count limit can be specified to filter out all
functions below the limit.

Profiling is done in the following steps:

cprof:start/0..3 Starts profiling with zeroed call counters for specified functions by setting call
count breakpoints on them.

Mod:Fun() Runs the code to be profiled.

cprof :pause/0. .3 Pauses the call counters for specified functions. This minimises the impact of code
running in the background or in the shell that disturbs the profiling. Call counters are
automatically paused when they “hit the ceiling” of the host machine word size. For a 32 bit host
the maximum counter value is 2147483647.

cprof:analyse/0..2 Collects call counters and computes the result.

cprof :restart/0..3 Restarts the call counters from zero for specified functions. Can be used to
collect a new set of counters without having to stop and start call count profiling.

cprof:stop/0..3 Stops profiling by removing call count breakpoints from specified functions.

Functions can be specified as either all in the system, all in one module, all arities of one function, one
function, or all functions in all modules not yet loaded. As for now, BIFs cannot be call count traced.

The analysis result can either be for all modules, or for one module. In either case a call count limit can
be given to filter out the functions with a call count below the limit. The all modules analysis does not
contain the module cprof itself, it can only be analysed by specifying it as a single module to analyse.

Call count tracing is very lightweight compared to other forms of tracing since no trace message has to
be generated. Some measurements indicates performance degradations in the vicinity of 10 percent.

The following sections show some examples of profiling with cprof. See also cprof(3) [page 45].

1.2.1 Example: Background work

From the Erlang shell:

1> cprof:start(), cprof:pause(). % Stop counters just after start

3476

2> cprof:analyse().

{30,

[{erleval,il,
[{{erl.eval,expr,3},3},

{{erl-eval,’-merge bindings/2-fun-0-’,2},2},
{{erl_eval,expand module name,2},1},
{{erl_eval,merge bindings,2},1},
{{erl_eval,binding,2},1},
{{erleval,exprlist,5},1},
{{erleval,exprlist,3},1},
{{erl_eval,exprs,4},1}1},
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{orddict,8,

[{{orddict,find,2},6},
{{orddict,dictto.list,1},1},
{{orddict,tolist,1},1}1},

{packages,7, [{{packages,is_segmented_1,1},6},
{{packages,is _segmented,1},1}1},
{lists,4, [{{lists,foldl,3},3},{{lists,reverse,1},1}1}1}
3> cprof:analyse(cprof).
{cprof,3, [{{cprof,tr,2},2},{{cprof,pause,0},1}1}
4> cprof:stop().
3476

The example showed the background work that the shell performs just to interpret the first command
line. Most work is done by erl_eval and orddict.

What is captured in this example is the part of the work the shell does while interpreting the command
line that occurs between the actual calls to cprof :start () and cprof:analyse().

1.2.2 Example: One module

From the Erlang shell:

1> cprof:start() ,R=calendar:day.of_the week(1896,4,27),cprof:pause(),R.

1

2> cprof:analyse(calendar).

{calendar,9,
[{{calendar,df,2},1},
{{calendar,dm,1},1},
{{calendar,dy,1},1},
{{calendar,last day of _themonthl,2},1},
{{calendar,last day of _themonth,2},1},
{{calendar,is leap_yearl,1},1},
{{calendar,is leap_year,1},1},
{{calendar,day of _the week,3},1},
{{calendar,date_to_gregorian days,3},1}1}

3> cprof:stop().

3271

The example tells us that “Aktiebolaget LM Ericsson & Co” was registered on a Monday (since the
return value of the first command is 1), and that the calendar module needed 9 function calls to
calculate that.

Using cprof :analyse () in this example also shows approximately the same background work as in the
first example.
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1.2.3 Example: In the code

Write a module:

-module(sort) .
-export([do/1]).

do(N) ->
cprof:stop(),
cprof:start(),
do(N, [1).

do(0, L) ->
R = lists:sort(L),
cprof :pause(),
R;
do(N, L) ->
do(N-1, [random:uniform(256)-1 | L]).

From the Erlang shell:

1> c(sort).

{ok,sort}

2> 1(random) .

3> sort:do(1000).
[0,0,1,1,1,1,1,1,2,2,2,3,3,3,3,3,4,4,4,5,5,5,5,6,6,6,6,6,6|...]
4> cprof:analyse().

{9050,

[{lists_sort,6047,
[{{lists_sort,merge32,6},923},
{{lists_sort,merge3_1,6},879},
{{lists_sort,split.2,5},661},
{{lists_sort,rmerge3_1,6},580},
{{lists_sort,rmerge32,6},543},
{{lists_sort,merge3.12.3,6},531},
{{lists_sort,merge3 21_3,6},383},
{{lists_sort,split.2.1,6},338},
{{lists_sort,rmerge3.21.3,6},299},
{{lists_sort,rmerge3_12.3,6},205},
{{lists_sort,rmerge2.2,4},180},
{{lists_sort,rmerge2.1,4},171},
{{lists_sort,merge2.1,4},127},
{{lists_sort,merge2.2,4},121},
{{lists_sort,mergel,2},79},
{{lists_sort,rmergel,2},27}1},

{random, 2001,

[{{random,uniform,1},1000},
{{random,uniform,0},1000},
{{random,seed0,0},1}1},

{sort,1001, [{{sort,do,2},1001}1},

{lists,1, [{{1lists,sort,1},1}]1}1}
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5> cprof:stop().
5369

The example shows some details of how lists:sort/1 works. It used 6047 function calls in the
module 1ists_sort to complete the work.

This time, since the shell was not involved, no other work was done in the system during the profiling.
If you retry the same example with a freshly started Erlang emulator, but omit the command
1(random), the analysis will show a lot more function calls done by code_server and others to
automatically load the module random.

1.3 The Erlang mode for Emacs

1.3.1 Purpose

The purpose of this user guide is to introduce you to the Erlang mode for Emacs and gives some
relevant background information of the functions and features. See also Erlang mode reference manual
[page 33] The purpose of the Erlang mode itself is to facilitate the developing process for the Erlang
programmer.

1.3.2 Pre-requisites

Basic knowledge of Emacs and Erlang/OTP.

1.3.3 Elisp

There are two Elsip modules include in this tool package for Emacs. There is erlang.el that defines the
actual erlang mode and there is erlang-start.el that makes some nice initializations.

1.3.4 Setup on UNIX

To set up the Erlang Emacs mode on a UNIX systems, edit/create the file . emacs in the your home
directory.

Below is a complete example of what should be added to a user's . emacs provided that OTP is installed
in the directory /usr/local/otp :

(setq load-path (cons "/usr/local/otp/lib/tools-<ToolsVer>/emacs"
load-path))

(setq erlang-root-dir "/usr/local/otp")

(setq exec-path (cons "/usr/local/otp/bin" exec-path))

(require ’erlang-start)
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1.3.5 Setup on Windows

To set up the Erlang Emacs mode on a Windows systems, edit/create the file . emacs, the location of the
file depends on the configuration of the system. If the HOME environment variable is set, Emacs will
look for the .emacs file in the directory indicated by the HOME variable. If HOME is not set, Emacs
will look for the . emacs filein C:\ .

Below is a complete example of what should be added to a user's . emacs provided that OTP is installed
in the directory C:\Program Files\erl<Ver>:

(setq load-path (cons "C:/Program Files/erl<Ver>/1lib/tools-<ToolsVer>/emacs"
load-path))

(setq erlang-root-dir "C:/Program Files/erl<Ver>")

(setq exec-path (cons "C:/Program Files/erl<Ver>/bin" exec-path))

(require ’erlang-start)

Note:

In .emacs, the slash character “/” can be used as path separator. But if you decide to use the backslash
character “\”, please not that you must use double backslashes, since they are treated as escape
characters by Emacs.

1.3.6 Indentation

The “Oxford Advanced Learners Dictionary of Current English” says the following about the word
“indent”:

“start (a line of print or writing) farther from the margin than the others”.

The Erlang mode does, of course, provide this feature. The layout used is based on the common use of
the language.
It is strongly recommend to use this feature and avoid to indent lines in a nonstandard way. Some
motivations are:
e Code using the same layout is easy to read and maintain.
¢ Since several features of Erlang mode is based on the standard layout they might not work
correctly if a nonstandard layout is used.

The indentation features can be used to reindent large sections of a file. If some lines use nonstandard
indentation they will be reindented.
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1.3.7 Editing

e M-x erlang-mode RET - This command activates the Erlang major mode for the current buffer.
When this mode is active the mode line contain the word “Erlang”.

When the Erlang mode is correctly installed, it is automatically activated when a file ending in .erl or
.hrl is opened in Emacs.

When afile is saved the name in the -module () . line is checked against the file name. Should they
mismatch Emacs can change the module specifier so that it matches the file name. By default, the user
is asked before the change is performed.

An “electric” command is a character that in addition to just inserting the character performs some type
of action. For example the “;” character is typed in a situation where is ends a function clause a new
function header is generated. The electric commands are as follows:

e erlang-electric-comma - Insert a comma character and possibly a new indented line.

e erlang-electric-semicolon - Insert a semicolon character and possibly a prototype for the next
line.

e erlang-electric-gt - “Inserta '>'-sign and possible a new indented line.

To disable all electric commands set the variable erlang-electric-commands to the empty list. In
short, place the following line in your . emacs-file:

(setq erlang-electric-commands ’())

1.3.8 Syntax highlighting

It is possible for Emacs to use colors when displaying a buffer. By “syntax highlighting”, we mean that
syntactic components, for example keywords and function names, will be colored.

The basic idea of syntax highlighting is to make the structure of a program clearer. For example, the
highlighting will make it easier to spot simple bugs. Have not you ever written a variable in lower-case
only? With syntax highlighting a variable will colored while atoms will be shown with the normal text
color.

1.3.9 Tags

Tags is a standard Emacs package used to record information about source files in large development
projects. In addition to listing the files of a project, a tags file normally contains information about all
functions and variables that are defined. By far, the most useful command of the tags system is its ability
to find the definition of functions in any file in the project. However the Tags system is not limited to
this feature, for example, it is possible to do a text search in all files in a project, or to perform a
project-wide search and replace.

In order to use the Tags system a file named TAGS must be created. The file can be seen as a database
over all functions, records, and macros in all files in the project. The TAGS file can be created using two
different methods for Erlang. The first is the standard Emacs utility “etags”, the second is by using the
Erlang module tags.
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1.3.10 Etags

etags is a program that is part of the Emacs distribution. It is normally executed from a command line,
like a unix shell or a DOS box.

The etags program of fairly modern versions of Emacs and XEmacs has native support for Erlang. To
check if your version does include this support, issue the command etags --help at a the command
line prompt. At the end of the help text there is a list of supported languages. Unless Erlang is a
member of this list | suggest that you should upgrade to a newer version of Emacs.

As seen in the help text — unless you have not upgraded your Emacs yet (well, what are you waiting
around here for? Off you go and upgrade!) — etags associate the file extensions .erl and .hrl with
Erlang.

Basically, the etags utility is runed using the following form:
etags filel.erl file2.erl

This will create a file named TAGS in the current directory.

The etags utility can also read a list of files from its standard input by supplying a single dash in place
of the file names. This feature is useful when a project consists of a large number of files. The standard
UNIX command find can be used to generate the list of files, e.g:

file . -name "*.[he]lrl" -print | etags -

The above line will create a TAGS file covering all the Erlang source files in the current directory, and in
the subdirectories below.

Please see the GNU Emacs Manual and the etags man page for more info.

1.3.11 Shell

The look and feel on an Erlang shell inside Emacs should be the same as in a normal Erlang shell. There
is just one major difference, the cursor keys will actually move the cursor around just like in any normal
Emacs buffer. The command line history can be accessed by the following commands:

e C-up or M-p (comint-previous-input)- Move to the previous line in the input history.

e C-down Or M-n (comint-next-input)- Move to the next line in the input history.

If the Erlang shell buffer would be killed the command line history is saved to a file. The command line
history is automatically retrieved when a new Erlang shell is started.

1.3.12 Compilation

The classic edit-compile-bugfix cycle for Erlang is to edit the source file in an editor, save it to a file and
switch to an Erlang shell. In the shell the compilation command is given. Should the compilation fail
you have to bring out the editor and locate the correct line.

With the Erlang editing mode the entire edit-compile-bugfix cycle can be performed without leaving
Emacs. Emacs can order Erlang to compile a file and it can parse the error messages to automatically
place the point on the erroneous lines.
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1.4 fprof - The File Trace Profiler

fprof is a profiling tool that can be used to get a picture of how much processing time different
functions consumes and in which processes.

fprof uses tracing with timestamps to collect profiling data. Therfore there is no need for special
compilation of any module to be profiled.

fprof presents wall clock times from the host machine OS, with the assumption that OS scheduling
will randomly load the profiled functions in a fair way. Both own time i.e the time used by a function for
its own execution, and accumulated time i.e execution time including called functions.

Profiling is essentially done in 3 steps:

1 Tracing; to file, as mentioned in the previous paragraph.

2 Profiling; the trace file is read and raw profile data is collected into an internal RAM storage on the
node. During this step the trace data may be dumped in text format to file or console.

3 Analysing; the raw profile data is sorted and dumped in text format either to file or console.

Since fprof uses trace to file, the runtime performance degradation is minimized, but still far from
negligible, especially not for programs that use the filesystem heavily by themselves. Where you place
the trace file is also important, e.g on Solaris /tmp is usually a good choice, while any NFS mounted disk
is a lousy choice.

Fprof can also skip the file step and trace to a tracer process of its own that does the profiling in runtime.

The following sections show some examples of how to profile with Fprof. See also the reference manual
fprof(3) [page 51].

1.4.1 Profiling from the source code

If you can edit and recompile the source code, it is convenient to insert fprof:trace(start) and
fprof :trace(stop) before and after the code to be profiled. All spawned processes are also traced. If
you want some other filename than the default try fprof:trace(start, "my fprof.trace").

Then read the trace file and create the raw profile data with fprof :profile(), or perhaps
fprof:profile(file, "my_fprof.trace") for non-default filename.

Finally create an informative table dumped on the console with fprof:analyse(), or on file with
fprof:analyse(dest, [1),or perhaps even fprof:analyse([{dest, "my_fprof.analysis"},
{cols, 120}1) for a wider listing on non-default filename.

See the fprof(3) [page 51] manual page for more options and arguments to the functions trace [page
53], profile [page 55] and analyse [page 56].

1.4.2 Profiling a function

If you have one function that does the task that you want to profile, and the function returns when the
profiling should stop, it is convenient to use fprof :apply(Module, Function, Args) and related for
the tracing step.

If the tracing should continue after the function returns, for example if it is a start function that spawns
processes to be profiled, you can use fprof :apply(M, F, Args, [continue | OtherOpts]). The
tracing has to be stopped at a suitable later time using fprof :trace(stop).
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1.4.3 Immediate profiling

It is also possible to trace immediately into the profiling process that creates the raw profile data, that is
to short circuit the tracing and profiling steps so that the filesystem is not used.

Do something like this:

{ok, Tracer} = fprof:profile(start),
fprof:trace([start, {tracer, Tracer}]),
%% Code to profile

fprof:trace(stop);

This puts less load on the filesystem, but much more on the Erlang runtime system.

1.5 Xref- The Cross Reference Tool

Xref is a cross reference tool that can be used for finding dependencies between functions, modules,
applications and releases. It does so by analyzing the defined functions and the function calls.

In order to make Xref easy to use, there are predefined analyses that perform some common tasks.
Typically, a module or a release can be checked for calls to undefined functions. For the somewhat more
advanced user there is a small, but rather flexible, language that can be used for selecting parts of the
analyzed system and for doing some simple graph analyses on selected calls.

The following sections show some features of Xref, beginning with a module check and a predefined
analysis. Then follow examples that can be skipped on the first reading; not all of the concepts used are
explained, and it is assumed that the reference manual [page 74] has been at least skimmed.

1.5.1 Module Check

Assume we want to check the following module:

-module (my module) .
-export ([t/1]).

t(A) ->
my_module:t2(4).

t2(0) ->
true.

Cross reference data are read from BEAM files, so the first step when checking an edited module is to
compile it:

1> c(mymodule, debug_info).
./mymodule.erl:10: Warning: function t2/1 is unused
{ok, my-module}
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The debug_info option ensures that the BEAM file contains debug information, which makes it
possible to find unused local functions.

The module can now be checked for calls to deprecated functions [page 75], calls to undefined
functions [page 75], and for unused local functions:

2> xref :m(mymodule)

[{deprecated, [1},

{undefined, [{{mymodule,t,1},{mymodule,t2,1}}1},
{unused, [{mymodule,t2,1}1}]

m/1 is also suitable for checking that the BEAM file of a module that is about to be loaded into a
running a system does not call any undefined functions. In either case, the code path of the code server
(see the module code) is used for finding modules that export externally called functions not exported
by the checked module itself, so called library modules [page 75].

1.5.2 Predefined Analysis

In the last example the module to analyze was given as an argument to m/1, and the code path was
(implicitly) used as library path [page 75]. In this example an xref server [page 74] will be used, which
makes it possible to analyze applications and releases, and also to select the library path explicitly.

Each Xref server is referred to by a unigue name. The name is given when creating the server:

1> xref:start(s).
{0k,<0.27.0>}

Next the system to be analyzed is added to the Xref server. Here the system will be OTP, so no library
path will be needed. Otherwise, when analyzing a system that uses OTP, the OTP modules are typically
made library modules by setting the library path to the default OTP code path (or to code_path, see the
reference manual [page 93]). By default, the names of read BEAM files and warnings are output when
adding analyzed modules, but these messages can be avoided by setting default values of some options:

2> xref:set_default(s, [{verbose,false}, {warnings,false}l).
ok
3> xref:add release(s, code:lib.dir(), {name, otp}).

{ok,otp}

add_release/3 assumes that all subdirectories of the library directory returned by code:1ib dir ()
contain applications; the effect is that of reading all applications’ BEAM files.

It is now easy to check the release for calls to undefined functions:

4> xref:analyze(s, undefined function_calls).

{ok, [...1}

We can now continue with further analyses, or we can delete the Xref server:

5> xref:stop(s).
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The check for calls to undefined functions is an example of a predefined analysis, probably the most
useful one. Other examples are the analyses that find unused local functions, or functions that call some
given functions. See the analyze/2,3 [page 85] functions for a complete list of predefined analyses.

Each predefined analysis is a shorthand for a query [page 82], a sentence of a tiny language providing
cross reference data as values of predefined variables [page 77]. The check for calls to undefined
functions can thus be stated as a query:

4> xref:q(s, "(XC -UC) || (XU - X - B)").
{ok,[...1}

The query asks for the restriction of external calls except the unresolved calls to calls to functions that
are externally used but neither exported nor built-in functions (the | | operator restricts the used
functions while the | operator restricts the calling functions). The - operator returns the difference of
two sets, and the + operator to be used below returns the union of two sets.

The relationships between the predefined variables XU, X, B and a few others are worth elaborating
upon. The reference manual mentions two ways of expressing the set of all functions, one that focuses
on how they are defined: X+L+B+U, and one that focuses on how they are used: UU+LU+XU. The
reference also mentions some facts [page 78] about the variables:

e Fisequal toL + X (the defined functions are the local functions and the external functions);

e U is a subset of XU (the unknown functions are a subset of the externally used functions since the
compiler ensures that locally used functions are defined);

B is a subset of XU (calls to built-in functions are always external by definition, and unused built-in
functions are ignored);

LU is a subset of F (the locally used functions are either local functions or exported functions,
again ensured by the compiler);

UU is equal to F-(XU+LU) (the unused functions are defined functions that are neither used
externally nor locally);

e UU is a subset of F (the unused functions are defined in analyzed modules).

Using these facts, the two small circles in the picture below can be combined.
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Definition

Definition and Use

Use

Figure 1.1: Definition and use of functions

It is often clarifying to mark the variables of a query in such a circle. This is illustrated in the picture
below for some of the predefined analyses. Note that local functions used by local functions only are
not marked in the locals not_used circle.

XU-X-B X - XU L* (UU + (XU - LU))
undefined_functions exports_not_used locals_not_used (simplified
(modules mode

Figure 1.2: Some predefined analyses as subsets of all functions

1.5.3 Expressions

The module check and the predefined analyses are useful, but limited. Sometimes more flexibility is
needed, for instance one might not need to apply a graph analysis on all calls, but some subset will do
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equally well. That flexibility is provided with a simple language. Below are some expressions of the
language with comments, focusing on elements of the language rather than providing useful examples.
The analyzed system is assumed to be OTP, so in order to run the queries, first evaluate these calls:

xref:start(s).
xref:add_release(s, code:root_dir()).

xref:q(s, "(Fun) xref : Mod"). Allfunctions of the xref module.

xref:q(s, "xref : Mod * X"). All exported functions of the xref module. The first operand of
the intersection operator * is implicitly converted to the more special type of the second operand.

xref:q(s, "(Mod) tools"). AIll modules of the tools application.

xref:q(s, ’"xref_.x" : Mod’). All moduleswith a name beginning with xref_.

xref:q(s, "# E|X"). Number of calls from exported functions.

xref:q(s, "XC|IL"). All external calls to local functions.

xref:q(s, "XCxLC"). All calls that have both an external and a local version.

xref:q(s, "(LLin) (LC * XC)"). The lines where the local calls of the last example are made.

xref:q(s, "(XLin) (LC * XC)"). The lines where the external calls of the example before last are
made.

xref:q(s, "XC * (ME - strict ME)"). External calls within some module.
xref:q(s, "El|lkernel"). All calls within the kernel application.

xref:q(s, "closureE|kernel| |kernel"). All directand indirect calls within the kernel
application. Both the calling and the used functions of indirect calls are defined in modules of the
kernel application, but it is possible that some functions outside the kernel application are used by
indirect calls.

xref:q(s, "{toolbar,debugger}:Mod of ME"). A chain of module calls from toolbar to
debugger, if there is such a chain, otherwise false. The chain of calls is represented by a list of
modules, toolbar being the first element and debugger the last element.

xref:q(s, "closure E | toolbar:Mod || debugger:Mod"). All (in)direct calls from functions in
toolbar to functions in debugger.

xref:q(s, "(Fun) xref -> xref base"). All function calls from xref to xref base.
xref:q(s, "E * xref -> xref base"). Same interpretation as last expression.
xref:q(s, "E || xref base | xref"). Same interpretation as last expression.

xref:q(s, "E * [xref -> lists, xref base -> digraph]l"). All function calls from xref to
lists, and all function calls from xref base to digraph.

xref:q(s, "E | [xref, xref base] || [lists, digraphl"). All function calls from xref and
xref_base t0o 1lists and digraph.

xref:q(s, "components EE"). Allstrongly connected components of the Inter Call Graph. Each
component is a set of exported or unused local functions that call each other (in)directly.

xref:q(s, "X * digraph * range (closure (E | digraph) | (L * digraph))"). All exported
functions of the digraph module used (in)directly by some function in digraph.

xref:q(s, "L * yeccparser:Mod - range (closure (E |

yeccparser:Mod) | (X * yeccparser:Mod))"). The interpretation is left as an exercise.
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1.5.4 Graph Analysis

The list representation of graphs [page 75] is used analyzing direct calls, while the digraph
representation is suited for analyzing indirect calls. The restriction operators (I, || and || |) are the
only operators that accept both representations. This means that in order to analyze indirect calls using
restriction, the closure operator (which creates the digraph representation of graphs) has to been
applied explicitly.

As an example of analyzing indirect calls, the following Erlang function tries to answer the question: if
we want to know which modules are used indirectly by some module(s), is it worth while using the
function graph [page 75] rather than the module graph? Recall that a module M1 is said to call a
module M2 if there is some function in M1 that calls some function in M2. It would be nice if we could
use the much smaller module graph, since it is available also in the light weight modules mode [page
74] of Xref servers.

t(S) —>

{ok, _} = xref:q(S, "Eplus := closure E"),

{ok, Ms} = xref:q(S, "AM"),

Fun = fun(M, N) —->
Q = io_lib:format("# (Mod) (Eplus | “p : Mod)", [MI),
{ok, NO} = xref:q(S, lists:flatten(Q)),
N + NO

end,

Sum = lists:foldl(Fun, O, Ms),

ok = xref:forget(S, ’Eplus’),

{ok, Tot} = xref:q(S, "# (closure ME | AM)"),

100 * ((Tot - Sum) / Tot).

Comments on the code:

¢ \We want to find the reduction of the closure of the function graph to modules. The direct
expression for doing that would be (Mod) (closureE|AM), but then we would have to represent
all of the transitive closure of E in memory. Instead the number of indirectly used modules is
found for each analyzed module, and the sum over all modules is calculated.

e A user variable is employed for holding the digraph representation of the function graph for use
in many queries. The reason is efficiency. As opposed to the = operator, the : = operator saves a
value for subsequent analyses. Here might be the place to note that equal subexpressions within a
guery are evaluated only once; = cannot be used for speeding things up.

e Eplus | "p : Mod. The | operator converts the second operand to the type of the first operand.
In this case the module is converted to all functions of the module. It is necessary to assign a type
to the module (:Mod), otherwise modules like kernel would be converted to all functions of the
application with the same name; the most general constant is used in cases of ambiguity.

e Since we are only interested in a ratio, the unary operator # that counts the elements of the
operand is used. It cannot be applied to the digraph representation of graphs.

¢ We could find the size of the closure of the module graph with a loop similar to one used for the
function graph, but since the module graph is so much smaller, a more direct method is feasible.

When the Erlang function t/1 was applied to an Xref server loaded with the current version of OTP,
the returned value was close to 84(percent). This means that the number of indirectly used modules is
approximately six times greater when using the module graph. So the answer to the above stated
question is that it is definitely worth while using the function graph for this particular analysis. Finally,
note that in the presence of unresolved calls, the graphs may be incomplete, which means that there
may be indirectly used modules that do not show up.
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Short Summaries

Erlang Module erlang.el [page 33] — Erlang mode for Emacs
Erlang Module cover [page 38] — A Coverage Analysis Tool for Erlang

Erlang Module cprof [page 45] — A simple Call Count Profiling Tool using
breakpoints for minimal runtime performance impact.

Erlang Module eprof [page 49] — A Time Profiling Tool for Erlang

Erlang Module fprof [page 51] — A Time Profiling Tool using trace to file for
minimal runtime performance impact.

Erlang Module instrument [page 64] — Analysis and Utility Functions for
Instrumentation

Erlang Module make [page 70] — A Make Utility for Erlang
Erlang Module tags [page 72] — Generate Emacs TAGS file from Erlang source files

Erlang Module xref [page 74] — A Cross Reference Tool for analyzing
dependencies between functions, modules, applications and releases.

erlang.el

No functions are exported.

cover

The following functions are exported:

start() -> {ok,Pid} | {error,Reason}
[page 39] Start Cover.

start (Nodes) -> {ok,StartedNodes}
[page 39] Start Cover on remote nodes.

compile(ModFile) -> Result
[page 39] Compile a module for Cover analysis.

compile(ModFile, Options) -> Result
[page 39] Compile a module for Cover analysis.

compilemodule(ModFile) -> Result
[page 39] Compile a module for Cover analysis.

compilemodule(ModFile, Options) -> Result
[page 39] Compile a module for Cover analysis.
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compiledirectory() -> [Result] | {error,Reason}
[page 40] Compile all modules in a directory for Cover analysis.

compiledirectory(Dir) -> [Result] | {error,Reason}

[page 40] Compile all modules in a directory for Cover analysis.
compile directory(Dir, Options) -> [Result] | {error,Reason}
[page 40] Compile all modules in a directory for Cover analysis.
compile beam(ModFile) -> Result

[page 40] Compile a module for Cover analysis, using an existing beam.

compile beam directory() -> [Result] | {error,Reason}
[page 40] Compile all .beam files in a directory for Cover analysis.

compile beam directory(Dir) -> [Result] | {error,Reason}
[page 40] Compile all .beam files in a directory for Cover analysis.

analyse(Module) -> {ok,Answer} | {error,Error}

[page 41] Analyse a Cover compiled module.

analyse (Module, Analysis) -> {ok,Answer} | {error,Error}

[page 41] Analyse a Cover compiled module.

analyse (Module, Level) -> {ok,Answer} | {error,Error}

[page 41] Analyse a Cover compiled module.

analyse(Module, Analysis, Level) -> {ok,Answer} | {error,Error}
[page 41] Analyse a Cover compiled module.

analyse_to_file(Module) ->
[page 41] Detailed coverage analysis of a Cover compiled module.

analyse_to_file(Module,Options) ->
[page 41] Detailed coverage analysis of a Cover compiled module.

analyse_to_file(Module, OutFile) ->
[page 41] Detailed coverage analysis of a Cover compiled module.

analyse_to_file(Module, OutFile, Options) -> {ok,OutFile}
{error,Error}
[page 41] Detailed coverage analysis of a Cover compiled module.

modules() -> [Module]
[page 42] Return all Cover compiled modules.

imported modules() -> [Module]
[page 42] Return all modules for which there are imported data.

imported() -> [File]
[page 42] Return all imported files.

which nodes() -> [Nodel
[page 42] Return all nodes that are part of the coverage analysis.

is_compiled(Module) -> {file,File} | false
[page 42] Check if a module is Cover compiled.

reset (Module) -> ok
[page 42] Reset coverage data for Cover compiled modules.

reset() -> ok
[page 43] Reset coverage data for Cover compiled modules.

export (ExportFile)
[page 43] Reset coverage data for Cover compiled modules.

export (ExportFile,Module) -> ok | {error,Reason}
[page 43] Reset coverage data for Cover compiled modules.
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e import(ExportFile) -> ok | {error,Reason}
[page 43] Reset coverage data for Cover compiled modules.

e stop() -> ok
[page 43] Stop Cover.

e stop(Nodes) -> ok
[page 43] Stop Cover on remote nodes.

cprof

The following functions are exported:
e analyse() -> {AllCallCount, ModAnalysisList}
[page 45] Collect and analyse call counters.

e analyse(Limit) -> {AllCallCount, ModAnalysisList}
[page 45] Collect and analyse call counters.

e analyse(Mod) -> ModAnlysis
[page 45] Collect and analyse call counters.

e analyse(Mod, Limit) -> ModAnalysis
[page 45] Collect and analyse call counters.

e pause() -> integer()
[page 46] Pause running call count trace for all functions.

e pause(FuncSpec) -> integer ()
[page 46] Pause running call count trace for matching functions.

e pause(Mod, Func) -> integer()
[page 46] Pause running call count trace for matching functions.

e pause(Mod, Func, Arity) -> integer()
[page 46] Pause running call count trace for matching functions.

e restart() -> integer()
[page 46] Restart existing call counters for matching functions.

e restart(FuncSpec) -> integer()
[page 46] Restart existing call counters for matching functions.

e restart(Mod, Func) -> integer()
[page 46] Restart existing call counters for matching functions.

e restart(Mod, Func, Arity) -> integer()
[page 46] Restart existing call counters for matching functions.

e start() -> integer()
[page 47] Start call count tracing for all functions.

e start(FuncSpec) -> integer()
[page 47] Start call count tracing for matching functions.

e start(Mod, Func) -> integer()
[page 47] Start call count tracing for matching functions.

e start(Mod, Func, Arity) -> integer()
[page 47] Start call count tracing for matching functions.

e stop() -> integer()
[page 47] Stop call count tracing for all functions.

e stop(FuncSpec) -> integer()
[page 47] Stop call count tracing for matching functions.
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e stop(Mod, Func) -> integer()
[page 47] Stop call count tracing for matching functions.

e stop(Mod, Func, Arity) -> integer()
[page 47] Stop call count tracing for matching functions.

eprof

The following functions are exported:
e start() -> {ok,Pid} | {error,Reason}
[page 49] Start Eprof.

e start profiling(Rootset) -> profiling | error
[page 49] Start profiling.

e profile(Rootset) -> profiling | error
[page 49] Start profiling.

e stop_profiling() -> profiling stopped | profiling already_stopped
[page 49] Stop profiling.

e profile(Rootset,Fun) -> {ok,Value} | {error,Reason} | error
[page 49] Start profiling.

e profile(Rootset,Module,Function,Args) -> {ok,Value} | {error,Reason}
| error

[page 49] Start profiling.

e analyse()
[page 50] Display profiling results per process.

e total_analyse()
[page 50] Display profiling results per function call.

e log(File) -> ok
[page 50] Activate logging of eprof printouts.

e stop() -> stopped
[page 50] Stop Eprof.

fprof
The following functions are exported:
e start() -> {ok, Pid} | {error, {already._started, Pid}}

[page 52] Starts the fprofserver.

e stop() -> ok
[page 52] Same as stop(normal).

e stop(Reason) -> ok
[page 52] Stops the fprofserver.

e apply(Func, Args) -> term()
[page 52] Same as apply(Func, Args, [1).

e apply(Module, Function, Args) -> term()
[page 52] Same as apply ({Module, Function}, Args, [1).

e apply(Func, Args, OptionList) -> term()
[page 52] Calls erlang:apply (Func, Args) surrounded by trace([start |
OptionList]) and trace(stop).
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e apply(Module, Function, Args, OptionList) -> term()
[page 53] Same as apply ({Module, Function}, Args, OptionList).

e trace(start, Filename) -> ok | {error, Reason} | {’EXIT’, ServerPid,
Reason}
[page 53] Same as trace([start, {file, Filename}]).

e trace(verbose, Filename) -> ok | {error, Reason} | {’EXIT’,
ServerPid, Reason}
[page 53] Same as trace([start, verbose, {file, Filename}]).

e trace(OptionName, OptionValue) -> ok | {error, Reason} | {’EXIT’,
ServerPid, Reason}
[page 53] Same as trace([{OptionName, OptionValue}l).

e trace(verbose) -> ok | {error, Reason} | {’EXIT’, ServerPid, Reason}
[page 54] Same as trace([start, verbosel).

e trace(OptionName) -> ok | {error, Reason} | {’EXIT’, ServerPid,
Reason}
[page 54] Same as trace ([OptionName]).

e trace({OptionName, OptionValue}) -> ok | {error, Reason} | {’EXIT’,
ServerPid, Reason}
[page 53] Same as trace ([{OptionName, OptionValue}l).

e trace([Option]) -> ok | {error, Reason} | {’EXIT’, ServerPid,
Reason}
[page 54] Starts or stops tracing.

e profile() -> ok | {error, Reason} | {’EXIT’, ServerPid, Reason}
[page 55] Same as profile([1).

e profile(OptionName, OptionValue) -> ok | {error, Reason} | {’EXIT’,
ServerPid, Reason}
[page 55] Same as profile([{OptionName, OptionValue}l).

e profile(OptionName) -> ok | {error, Reason} | {’EXIT’, ServerPid,
Reason}
[page 55] Same as profile([OptionName]).

e profile({OptionName, OptionValue}) -> ok | {error, Reason} |
{’EXIT’, ServerPid, Reason}
[page 55] Same as profile([{OptionName, OptionValue}l).

e profile([Option]) -> ok | {ok, Tracer} | {error, Reason} | {’EXIT’,
ServerPid, Reason}
[page 55] Compiles a trace into raw profile data held by the fprofserver.

e analyse() -> ok | {error, Reason} | {’EXIT’, ServerPid, Reason}
[page 56] Same as analyse([]).

e analyse(OptionName, OptionValue) -> ok | {error, Reason} | {’EXIT’,
ServerPid, Reason}
[page 56] Same as analyse([{OptionName, OptionValue}l).

e analyse(OptionName) -> ok | {error, Reason} | {’EXIT’, ServerPid,
Reason}
[page 56] Same as analyse ( [OptionName]).

e analyse({OptionName, OptionValue}) -> ok | {error, Reason} |
{’EXIT’, ServerPid, Reason}
[page 56] Same as analyse([{OptionName, OptionValue}l).

e analyse([Option]) -> ok | {error, Reason} | {’EXIT’, ServerPid,
Reason}
[page 56] Analyses raw profile data in the fprofserver.
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instrument

The following functions are exported:

e allocator_descr(MemoryData, TypeNo) -> AllocDescr | invalid_type |
"unknown"
[page 65] Returns a allocator description

e block header_size(MemoryData) -> int()
[page 65] Returns the memory block header size used by the emulator that
generated the memory allocation map

e class_descr (MemoryData, TypeNo) -> ClassDescr | invalid_type |
"unknown"
[page 65] Returns a allocator description

e descr(MemoryData) -> DescrMemoryData
[page 65] Replace type numbers in memory allocation map with type descriptions

e holes(MemoryData) -> ok
[page 66] Print out the sizes of unused memory blocks

e mem limits(MemoryData) -> {Low, High}
[page 66] Return lowest and highest memory address used

e memory._data() -> MemoryData | false
[page 66] Return the current memory allocation map

e memory_status(StatusType) -> [StatusInfo] | false
[page 66] Return current memory allocation status

e read memory data(File) -> MemoryData | {error, Reason}
[page 67] Read memory allocation map

e read memory status(File) -> MemoryStatus | {error, Reason}
[page 67] Read memory allocation status from a file

e sort(MemoryData) -> MemoryData
[page 68] Sort the memory allocation list

e store memory data(File) -> true|false
[page 68] Store the current memory allocation map on a file

e storememory.status(File) -> true|false
[page 68] Store the current memory allocation status on a file

e sum blocks(MemoryData) -> int()
[page 68] Return the total amount of memory used

e type_descr(MemoryData, TypeNo) -> TypeDescr | invalid_type
[page 69] Returns a type description

e typeno_range(MemoryData) -> {Min, Max}
[page 69] Returns the memory block type numbers

make

The following functions are exported:

e all() -> up-to_date | error
[page 70] Compile a set of modules.

e all(Options) -> up-to_date | error
[page 70] Compile a set of modules.
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files(ModFiles) -> up_to_date | error
[page 70] Compile a set of modules.

files(ModFiles, Options) -> up_to_date | error
[page 70] Compile a set of modules.

tags

The following functions are exported:

file(File [, Options])
[page 72] Create a TAGS file for the file File.

files(FileList [, Options])
[page 72] Create a TAGS file for the files in the list FileList.

dir(Dir [, Options])
[page 72] Create a TAGS file for all files in directory Dir.

dirs(DirList [, Optiomns])
[page 72] Create a TAGS file for all files in any directory in DirList.

subdir(Dir [, Optiomns])
[page 72] Descend recursively down the directory Dir and create a TAGS file based
on all files found.

subdirs(DirList [, Options])
[page 72] Descend recursively down all the directories in DirList and create a
TAGS file based on all files found.

root ([Options])
[page 72] Create a TAGS file covering all files in the Erlang distribution.

xref

The following functions are exported:

add_application(Xref, Directory [, Options]) -> {ok, application()}
| Error

[page 83] Add the modules of an application.

add_directory(Xref, Directory [, Options]) -> {ok, Modules} | Error
[page 83] Add the modules in a directory.

add-module(Xref, File [, Options]) -> {ok, module()} | Error
[page 83] Add a module.

add_release(Xref, Directory [, Options]) -> {ok, release()} | Error
[page 84] Add the modules of a release.

analyze(Xref, Analysis [, Options]) -> {ok, Answer} | Error
[page 84] Evaluate a predefined analysis.

d(Directory) -> [DebugInfoResult] | [NoDebugInfoResult] | Error
[page 86] Check the modules in a directory using the code path.

forget (Xref) -> ok
[page 86] Remove user variables and their values.

forget (Xref, Variables) -> ok | Error
[page 86] Remove user variables and their values.
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format_error (Error) -> character_list()
[page 86] Return an English description of an Xref error reply.

get_default (Xref) -> [{Option, Value}]
[page 87] Return the default values of options.

get_default (Xref, Option) -> {ok, Value} | Error
[page 87] Return the default values of options.

get_library path(Xref) -> {ok, LibraryPath}
[page 87] Return the library path.

info(Xref) -> [Info]
[page 87] Return information about an Xref server.

info(Xref, Category) -> [{Item, [Infol}]
[page 87] Return information about an Xref server.

info(Xref, Category, Items) -> [{Item, [Info]}]
[page 87] Return information about an Xref server.

m(Module) -> [DebugInfoResult] | [NoDebugInfoResult] | Error
[page 90] Check a module using the code path.

m(File) -> [DebugInfoResult] | [NoDebugInfoResult] | Error
[page 90] Check a module using the code path.

q(Xref, Query [, Options]) -> {ok, Answer} | Error
[page 90] Evaluate a query.

remove_application(Xref, Applications) -> ok | Error
[page 91] Remove applications and their modules.

remove module (Xref, Modules) -> ok | Error
[page 91] Remove analyzed modules.

remove_release(Xref, Releases) -> ok | Error
[page 92] Remove releases and their applications and modules.

replace_application(Xref, Application, Directory [, Options]) ->
{ok, application()} | Error
[page 92] Replace an application’s modules.

replacemodule(Xref, Module, File [, Options]) -> {ok, module()}
Error
[page 92] Replace an analyzed module.

set_default (Xref, Option, Value) -> {ok, 0ldValue} | Error
[page 93] Set the default values of options.

set_default(Xref, OptionValues) -> ok | Error
[page 93] Set the default values of options.

set_library path(Xref, LibraryPath [, Options]) -> ok | Error
[page 93] Set the library path and finds the library modules.

start (Xref [, Options]) -> Return
[page 93] Create an Xref server.

stop (Xre